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Chapter 1.1

Welcome to SoftWood GS File - the database management system
designed for use in both home and small business. Although easy to learn
and operate, the system offers sophisticated and powerful data
management features.

About SoftWood GS File

SoftWood GS File is a tool used to manage information. You define the
nature of information that SoftWood GS File is to manage by setting up
columns. Each column relates to a particular element of data called a field,
e.g., name or address. Rows are used to store complete instances of
related data. For example, a person's name, address, city, state, and zip
code would all be stored in a row. Together, the rows and columns com-
prise a database. SoftWood GS File is a database management system,

System Requirements

SoftWood GS File operates on the Apple IIGS™ computer with at least
256K of add on memory. A SoftWood GS File database is contained
entirely within the computer's memory. The maximum size (number of
rows and columns) of a database depends upon the amount of memory
available at the time SoftWood GS File is started. There may be multiple
databases, although only one may be used at a time. Using just 512K,
you will have sufficent system resources for most needs. To increase the
amount of information maintained, additional memory, floppy drive, and
hard disk can be used.

Who Can Use SoftWood GS File

Due to the versatility of SoftWood GS File, there are numerous uses for
it. Home makers can create budgets for home use. Lists of friends and
relatives addresses can be viewed at a glance. Students can sort their
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Introduction

reading material for courses in terms of priority for specific due dates.
Business people can create mailing lists from their files of customers who
need certain reorder items.

With SoftWood GS File, you will continually find new applications for
your everyday needs.

What Comes with SoftWood GS File

Contained in the SoftWood GS File package are: 1) Program disk, 2)
User manual, and 3) Warranty/Registration card. If any of these are
missing, please contact your dealer or SoftWood Company.

Warranty / Registration Card

Support of a technical nature is available if you fill out and send the
enclosed Warranty/Registration Card to SoftWood Company. For a
nominal cost, as a registered owner, you will have the opportunity to
upgrade your version as new major versions of SoftWood GS File
become available.

How To Use This Manual

The SoftWood GS File user manual consists of three sections: 1) System
Overview, 2) Tutorial, and 3) Reference Guide. Illustrations are provided
throughout the manual.

Section one, "System Overview", provides you with a look at the
SoftWood GS File system as a whole. It should be read before going on
to other areas of the manual. Section one is organized into two chapters.
This chapter introduces the system and manual. The next chapter, "Mini-
Session", contains a brief SoftWood GS File session using a
demonstration database provided on the program disk.

Chapter 1.1: Introduction 7



Section two, "Tutorial", provides detailed, step-by-step instructions on
how to use the system. It is intended for first time users and assumes you
know nothing about the details of operating SoftWood GS File. This
section is organized into six chapters. The purpose of the tutorial is to
provide you with details on how to install and effectively use SoftWood
GS File. Even if you already know database management principles, you
should read and follow the examples in this section. It provides the fastest
way to learn how to operate SoftWood GS File.

Section three, "Reference”, is designed to provide quick access to
information on specific SoftWood GS File functions. It is most
effectively used if you already have a working knowledge of the program.
"Operating Environment" explains the elements of the SoftWood GS File
user interface including the SoftWood GS File window. "Menu Items"
discusses the use and availability of each of the system's menus.
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Notes:
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Chapter 1.2

This chapter contains a very short SoftWood GS File session. In this
session you will learn how to start the program, open a database, sort a
database, search for specific information, and finally quit the program.

Starting SoftWood GS File

SoftWood GS File comes on a standard Apple IIGS™ program disk.
Once the disk is inserted and accepted by the system, you will see the
program launcher menu containing the SoftWood GS File program name.
Double click on the name GSFILE. Within a few seconds SoftWood GS
File will load itself into memory and display the following screen.

& File Column Select Sort Options Print Uiew

Untitled
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Getting Started

Opening a Database

You now have the choice of either beginning a new database or accessing
one that has already been created. You will be accessing a demonstration
database provided on the SoftWood GS File program disk. Select "Open"
from the "File" menu. SoftWood GS File will display a list of all
databases in the directory and drive from which the program was started.

mcmumn Select Sort Options Print Diew

Untitied

Select the file you want to open:
/Sottlood/
&y CALCDEMO ( Disk )

&x IMPORTNEMO

@ Open )

( Quit

Position the mouse pointer on the line containing "Listings" and double
click the mouse button. SoftWood GS File responds by reading the disk
file named "Listings" into memory so that it may be processed. Once the
file is read, the program displays as much of the file's information that
will fit on the screen. Once this has been done the file may be used.
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& File Column Select Sort Options Print liew

Southwest Real Estate For Sale

Duzelling Location Beds;Baths! Garage Price
4 $5,000,000
$4,000,000
$1,400,000
$1,250,000
$1,000,000
$900,000
$750,000
$600,000
$500,000
$450,000
$450,000
$400,000

House San Francisco
House San Clemente
House Malibu
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S

Penthouse [Century City

Beach House ;Malibu
House Tucson
Beach House ; Santa Barbara
Beach Hause | Santa Barbara
House Santa Barbare
House San Francisco
Duplex Encino
San Francisco
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Wi WINIWIW Wi AU
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CIWINIZININI<iW!Dd

N
~
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N

Sorting a Database

Click the mouse on the name "Location" that appears as the heading of one
of the columns on the list in front of you. Notice how the word's letters
change from black on white to white on black when you click on it. When
the letters are highlighted in this way, the column is selected for some
action. Next, choose "Low to High" from the "Sort" menu.

& Fite Column Select K41

Options Print Diew

Estate For Sale

High to Low

Dwelling Single Uplume aths | Garage] Pool Price

House Progressiue 4 4 Yes | $5,000,000
Hnnan AN I 0 T4 a vae 4 nnn nnn

AN

SoftWood GS File responds by arranging the rows in order by data in the
"Location" column.
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Getting Started

Searching for Specific Information

Click the mouse on the column heading name "Price". Next, choose "By
Range" from the "Select” menu. SoftWood GS File responds by
displaying a window on top of the list. This window is used to specify
range values for a search.

Type in 200000 in the area labeled "Is From". Next, press the tab key.
Once the tab key is pressed the program advances to the area labeled
"Through". Type in 300000 in the area labeled "Through".

& File Column RUILG{!Sort Options Print Uiew

Southwest Real Estate For Sale

Dwelling Location BedsiBaths|Garage Price

Townhouse |Apache duncti 3 2 2 No $60,000

Hou $175,000

Tow Include = $77,000
QO Exciude @

Hou $90,000
information when data

Houtl in cotumn Price $150,000

Houll s from [200000 $90,000

Hou

through [ 360000 $253,000
Pen 1,250,000

Hou $115,000
House San Francisco $100,000
Duplex Encino $250,000

Condo Encino 1cisco $200,000

Wi IDIWIN -

Finally, click the mouse on the OK button. SoftWood GS File responds
by searching for all rows in the "Listings" database containing "Price" data
between $200,000 and $300,000. Once this information is located,
SoftWood GS File will display only these rows on the screen.
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Quitting SoftWood GS File

Select "Quit" from the "File" menu. Because you sorted your database
above, SoftWood GS File asks you if you wish to save the changed
database. Click the mouse on the "No" button. The program then returns
to the standard program launcher.
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Notes...
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Chapter 2.1

This is a tutorial on how to use SoftWood GS File. It contains detailed
"how to" instructions covering the system's processing. Even if you are
experienced in database management programs, you should follow the
examples in this tutorial since they provide the fastest way to become
familiar with SoftWood GS File. This chapter explains how to define a
database.

Start SoftWood GS File

Start the SoftWood GS File program by "double clicking" the mouse on
the "GSFILE" name seen on the program launcher menu.

¢3 Apple 116S Program Launcher Version 1.0

Select the file you want to open:
B /softwood/

& PRODUS
(7 SYSTEM

Designing a Database

A SoftWood GS File database definition consists of one or more column
definitions that describe a set of related items. For example, a name and
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Defining a Database

address database might consist of the columns: name, address, city, state,
zip code, and phone number.

& File Column Select Sort Options Print View

Untitled

The first step in designing a database is to decide what type of information
you wish to store in the database. The number and type of columns
defined can have a big effect on the usefulness of your database. For
example, in a name and address database, your first thought might be to
use one column for a person's name. Upon further analysis, however,

you realize that you will at some time want to arrange people's names in
your database by their last name. If only one name column is used, you
must enter names with the last name first and first name last in order to be
able to later arrange them by last name. This method will allow desired
arrangement by last name, however, when you print labels, the person's
name will also be printed on the label with their last name first - which
may not be acceptable. So instead of using one name column, you might
decide to use two columns; one for first name and one for the last.

Chapter 2.1: Lesson One - Defining a Database 17



Defining Data Columns

Prior to entering data, you must define columns to hold the data. In this
tutorial, you will be working with asmall Time Sheet database. This
database will be defined with 6 columns titled: "Name", "Project”, "Date",
"Hours", "Rate"”, and "Bill".

Begin to define the "Name" column by selecting'Define Data" from the
"Column" menu. The program responds by displaying a dialogue
window that allows you to define a new column. Enter Name in the area
labeled "Column Name". Next, click the mouse on the "TEXT" button.
Now, click the mouse on the OK button at the lower left corner of the
window.

& File elect Seort Options Print Diews

Untitled

Column Name

Column Type

Tent 8 ves/No
() Amount Phone

8 Date 8 fAlpha
Time /N

SoftWood GS File responds by redrawing the list screen with a new
column labeled "Name". This is how columns are defined.

18 Chapter 2.1: Lesson One - Defining a Database



Defining a Database

Once again, select "Define Data" from the "Column" menu. When the
new column dialogue window is displayed, observe the buttons labeled
Text, Amount, Date, etc. These buttons allow you to specify the type of
column being defined.

& File Select Sort Options Print Diew

Untitied

¢ aw )
Column Tg)e ,

Tent Yes/No
% Amount § Phone

Date flpha
Time A/N

Notice that the "Text" button contains a black circle. This indicates that
"Text" is the default column type. This means that if you do not click the
mouse on a type button, the column will be defined as a "Text" column.

SoftWood GS File uses a column's type definition to verify that the data
you enter is valid for the column's type. For example, "Hello there"
entered as data for a column defined as a "Time" type column is invalid
and therefore will not be acceptable. This is one of the ways the program
assists you in managing your data.

Next, notice the two buttons labeled "OK" and "Cancel". These buttons

are referred to as exit buttons - they allow you to exit from a dialogue
window. In the new column dialogue window, the "OK" button

Chapter 2.1: Lesson One - Defining a Database 19



has an extra border around it. This indicates that "OK" is the default exit
button. This means that you may simply press the RETURN key to select
"OK" when it is more convenient to do so than clicking the mouse in the
"OK" button.

At this time, enter "Project” for the column name, and press the RETURN
key. Your list will be redrawn with two columns labeled "Name" and
"Project".

Next select "Define Data" once again and define the third column and title
it "Date". Specify that it is a Date type column by clicking the mouse in
the column type button labeled "Date". Date type columns are used to
enter month, day, and year data. SoftWood GS File verifies each date
entered as being a valid date. For example, 2/30/87 (February 30, 1987)
is not a valid date. Click OK to complete the column's definition.

Next use "Define Data" to define the "Hours" column. Specify that this
field is an amount by clicking the mouse in the "AMOUNT" column type
button. The program will only allow valid amount data to be entered into
"AMOUNT" columns, e.g., 123, -400.23, etc.

Finally, use "Define Data" to define the "Rate" amount column. Be sure to
specify that this column is of "AMOUNT" type.

Now five of the six columns have been defined.

Defining Calc Columns

The last column to be defined is the "Bill" column. The purpose of this
column is to show the amount to be billed for the time reported. Choose
"Define Calc" from the "Column" menu. The program responds by
displaying a dialogue window that allows you to define a calculation.

20 Chapter2.1: Lesson One - Defining a Database



Defining a Database

& File Welecl sort Dptions Print Biews

Untitled

H i i
INﬂmn iprojact | Nate:  Hours:

Column Name: BiN

Calculation:
[ HOURS * RATE

Enter the column's name as Bill. Next, enter HOURS*RATE in the
calculation area. The asterisk "*" entered is the multiplication sign.
Finally, click the mouse in the OK button to accept the new column's
definition. The program responds as usual by displaying the new column
title on the list. You have now defined a calculation column whose data
will be supplied by the program by multiplying "Hours" times "Rate".

Moving Columns

Observing the columns in your list, you will see that each column was
placed to the right of the column defined before it. SoftWood GS File
allows you to easily change the order in which columns appear on the list.
Let's say you really would rather have the "Name" column appear after the
"Project” column. Move the mouse so that the mouse's arrow is over the
word "Name" at the top of the "Name" column. Press the left mouse
button down and continue to hold it.

Chapter 2.1: Lesson One - Defining a Database 21



¢ FHe Column Select Sort Options Print View

Untitled

Project Date; Hours

Notice that a faint outline is drawn around the entire column. While
continuing to hold the mouse button down, move the mouse to the right.
This process is referred to as "dragging the mouse”. Continue to drag the
mouse to the right until the left boundary of the outline moves just past the
left boundary of the "Project” column. When you have done this, release
the mouse button. If you did this procedure properly, the "Name" column
should now be seen after the "Project” column. This is how you move a
column. Columns may be moved at any time - even when they contain
data.

Changing Column Widths

Notice that all columns in your list have the same width. This is a default
width set by the program when the column was defined. In looking at the
"Name" column, you decide to make the column's width larger so that
more of a person's name may be seen in it. Move the mouse so that the
mouse's arrow approaches the right boundary of the "Name" column.
Once the mouse is almost over the boundary, the mouse arrow changes to
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Defining a Database

a vertical bar joining a left and right arrow. This new mouse pointer
appears to alert you that you are over the boundary of a column and may
move that boundary either to the left or to the right. As soon as you see
this mouse pointer, press the left mouse button down and continue to hold
it down. Notice the faint outline drawn around the column's right
boundary.

& File Column Seilect Sort Options Print Uiew

Untitled

Project Date Hours

While continuing to hold the button down, drag the mouse to the right for
about an inch. After dragging the mouse an inch, release its button. If
you have done this procedure correctly, the width of the "Name" column
should now be wider than the other columns. This is how you increase a
column's width. To decrease a column's width you drag the mouse to the
left instead of the right. Column widths may be changed at any time -
even when they contain data.

Chapter 2.1: Lesson One - Defining a Database 23



Changing a Column's Name

Sometimes you may decide to change the name of a column. Usually this
is to more accurately reflect the type of data you are entering into the
column. Move the mouse so that the mouse's arrow is over the word
"Date" at the top of the "Date" column. Press the left mouse button down
and then release it. Observe that now the word "Date" is drawn in light
letters on a dark background. This process is referred to as "selecting a
column" and will be done many times while working with your database.
When a column is selected it is ready for some futher action.

When the "Date" column is selected, choose "Define Data" from the
"Column" menu. The program responds by drawing the dialogue for
defining columns. This time, however, the dialogue is already filled in
with the definition of the "Date" column. Change the word "Date" to "The
Date". Next click the mouse in the OK button. The program responds by
redrawing the list with the new name for the date column. This is how
you can change a column’s name. You may change a column's name at
any time.

Changing a Column's Type

As long as no data has been entered into a database, you may change any
column's type. Select the "Name" column as you did in the previous
section. Choose "Define Data" from the "Column" menu. Click the
mouse on the "A/N" column type button. Next, click the mouse on the
OK button. You have just instructed SoftWood GS File to only accept
alpha-numeric characters in the "Name" column.
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Formatting Amounts

Amount columns (types AMOUNT and CALC) may be displayed in a
variety of formats. The initial format of an amount column depends upon
how the default display format is set. Each column may also be
individually formatted. A column's format definition affects the way the
column's data is shown on the list and on reports.

The "Hours", "Rate", and "Bill" columns in your database are amounts
that have already been defined with a default display format. Click the
mouse on the "Hours" column title. Now choose "Display Format" from
the "Column" menu. The program responds by displaying a dialogue
window that allows you to specify the display format of "Hours".

& Flle (/v Salect Sort Options Print Mew

Untitled
1 1

3 i Dodol 2

Hours Display Format: Currency Symbol;

@9,599.99 OY Oors -)

(9.999,99 Qe Obokr OL.

09 999.99 Om O Krr Os -Cancel
OF  Osik On
QFfr. Qos OTL

Number of Decimals Ort Omk QNone
® None
Q one

The three buttons at the upper left side of the window are for defining the
way commas and decimals are to appear. The three buttons at the lower
left side of the window are for defining the number of decimals that are to
appear. The 3 columns of buttons at the upper right half of the window
are for defining the currency symbol (if any) that is to appear..
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You will be defining the format of the "Hours" column to show only one
decimal and not to have a currency symbol. Click the mouse on the "One"
under "Number of Decimals". Next click the mouse on the currency
symbol titled "None". Finally, click the mouse on the OK button. Now,
whenever "Hours" is shown in a column or on a report, it will be
formatted with only one decimal and with no currency symbol. You may
change this format at any time - even after you have entered data.

Formatting Dates

Date columns may be displayed in a variety of formats. The initial format
depends upon the default display format of Date type columns. Each Date
column may also be individually formatted.

Click the mouse on the "The Date" column title. Now choose "Display
Format" from the "Column" menu. The program responds by displaying

a dialogue window that allows you to specify the display format of
"Date".

& File Select Sort Options Print View

Untitled

The Date Display Format:

Vear Month Weekday Format Bivider

@YY @hnn nnv @Hone @/
O9vy O unn O

yip  Oobop .
BHiH ony BOOD

11/13/87
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Defining a Database

Saving A Database

Presently, the database you have defined resides entirely in the computer's
memory. If you turned the computer's power off, you would lose the
database and have to redefine it. In order to make your database
permanent, you must instruct SoftWood GS File to write it to disk. To do
this, select "Save" from the "File" menu. The program responds by
displaying a dialogue window prompting you to enter the name of your
new database. Name your database "Tutorial".

mcmumn select Sort Options Print Uiew

Untitled

/SoftWood/
Free: 366K out of 800K,

& ColcBems ( Disk )
& tmportdemn (——mw Folder

& Listlogs
S o

€ PRODOS

(1 SYSTEM tose )
Name of new file is,, Save

LTutorial| J hcancel )

! ; !

Finally, click the mouse in the dialogue window's "Save" exit button.

Summary

You now know how to define a new database. In the next chapter you
will learn about the database "Form". If you would like, you can quit

SoftWood GS File now and continue with the next chapter later. Since
your database is saved to disk, it can be opened and accessed any time.
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Chapter 2.2

In this chapter of the tutorial you will learn about the SoftWood GS File
database "Form". At this time, start the SoftWood GS File program, if it
is not already started.

Opening an Existing Database

In this chapter you will be using the database created and saved to disk in
Lesson One. To open a saved database, choose "Open" from the "File"
menu. When you do this the program displays a dialogue window
allowing you to specify which database you wish to open. Shortly, you
will see a list of names in the dialogue window. The name that you are
interested in here is titled "Tutorial".

& File Column Select Sort Options Print Ulew

gg v 7
b

Untitied

Select the file you want to open:
/Softlood/

%w Calc.Demo ( Disk )

%1 Import.Demo
| €y _Listings

(C_open_)

( auit )

To open the "Tutorial" database, move the mouse pointer over the line
containing the name "Tutorial" and double click the mouse. The program
responds by removing the dialogue window from the
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Modifying the Form

display, opening the "Tutorial" database, reading in its information, and
displaying its columns on the screen. The database is now open and ready
for processing.

Accessing the Database Form

All data entered into a database is done so via the database form. In
addition to entering new data, the form is also used to remove and modify
existing information. At this time, select "Form" from the "Options"

menu. The program responds by displaying the form it created for the
"Tutorial" database.

& File Column Select Sort Options Print View

Observe the contents of the form. Along the left side of the form you will
see six rectangles stacked vertically with names the same as the columns
you defined. These boxes are referred to as data entry boxes. This form
was automatically created when you defined your first column, and
automatically updated each time you defined an additional column. You
may use the form "as is", or change its arrangement to suit your needs.
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Changing a Form's Layout

The ideal form layout is one in which all information for a record (related
set of columns) may be seen on the screen at the same time, each data
entry box is large enough to show all data contained in it, and all data
entry boxes are placed in a logical and easy to view manner. Sometimes
you will want certain data entry boxes at special locations. For example,
in a name and address database, you will probably want the first 5 lines of
the form to resemble a mailing label. Later when you print from the form,
the information will be printed as a mailing label. This will be discussed
in a future lesson. The important thing to understand at this time is that
you may want to give some thought to the ultimate arrangement of the data
entry boxes on a form. This arrangement is referred to as a form's layout.

There are many layouts or arrangements possible for a form.You can
change a form's layout at any time - even after you have entered data into
your database. A form is arranged by placing and sizing data entry boxes
on lines within the form. The height of a line is the height of a data entry
box. The width of a line is the same as the form area seen on the screen.
Each form line is capable of holding as many as 8 different data entry
boxes aligned horizontally.

Changing the Width of a Data Entry Area

Move the mouse pointer over the right boundary of the data entry box
labeled "Name". Press the left mouse button and continue to hold it.

é File Column Select Sort Options Print liew

Tutorial

Notice the outline that appears around the right boundary area. While
holding the mouse button down, drag the mouse to the right. After you
have moved the mouse about an inch, release the mouse button.
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& File Column Select Sort Options Print UView

Tutorial

The program responds by redrawing the "Name" data entry box. This is
how you expand the width of a data entry box. If you had moved the
mouse to the left, you would have contracted the data entry box's width.

Changing the Width of a Data Entry Prompt Area

Move the mouse pointer over the vertical line that appears after the word
"Project"” in the second data entry box. This line separates the data entry
area of a box to the right from the prompt area on the left. Next, press the
left mouse button and continue to hold it down. Notice the outline that
appears around the vertical line.

¢ File Column Select Sort Options Print View

Project

While holding the mouse button down, drag the mouse to the left. After
you move the mouse a quarter of an inch or so, release the mouse button.
The program responds by redrawing the "Project” data entry box.

& Flle Column Select Sort Optlons Print Ylew
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Moving a Data Entry Box to a New Line.

Move the mouse pointer over the word "Rate" on the next to last data entry
box. Now, press the left mouse button and continue to hold it down.
Notice the blue outline that appears around the entire data entry box.

While holding the mouse button down, drag the mouse upward on your
desk so that the outline moves to the previous line on the form. While still
holding down the mouse button, drag the mouse a little distance to the
right.

Now release the mouse button. SoftWood GS File responds by removing
the "Rate" data entry box from the last line and inserting it on the same line
as the "Hours" data entry box. This is how to move a data entry box.
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Modifying the Form

Saving a Form Layout

Just as you saved your column definitions in Lesson One, you will now
save the Form layout here. To do this, select "Save" from the "File"
menu. Since the database you are saving has already been saved once,
SoftWood GS File will not prompt you for a new database name.
Instead, it simply replaces the previously saved version of the database
with the current one. Now whenever you open your database and access
the form, it will appear as it did when you saved it.

Exiting the Form

Return to the column or list format by choosing "List" from the "Options"
menu. The program responds by displaying the database's columns.

Summary

You now know about the database form, how to access it, modify it, and
return to the list screen. In the next lesson you will learn how to enter data
into your database. Since you saved your database in the "Saving a Form
Layout" section, you may quit the program and start the next lesson at a
later time. The next time you open your database, it will be in the same
state as it is now.
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Chapter 2.3

In this lesson, you will learn how to enter data into a SoftWood GS File
database. Start the SoftWood GS File program (if not already started),
and open the "Tutorial" database (if not already opened).

The Field, the Record, and the File

"Field" is a term that refers to an element of data. For example, a Name,
address, or salary amount, Earlier you defined fields when you defined
columns, "Record" refers to a group of related fields. For example, a
name and address record might consist of the fields: Name, Address,

City, State, Zip Code, and Phone. A data record exists when actual data
has been entered into a record, i.e., Loey, 404 W. Elm, Santa Barbara,

CA, 993-3443. A "File" is a collection of related records. For example,
the names in a Holiday Mailing List might be a different file than names in
a Client Roster. In SoftWood GS File, column refers to field, row refers
to record, and database refers to file.

Quick Access to Form

In the previous lesson you learned how to access the database form by
selecting "Form" from the "Options" menu. At this time, position the
mouse pointer over the word "New" on the left side of the screen.

& File Column Select Sort Options Print View

Tutorial

Project The Date

Click the left mouse button once.The program responds by displaying the
database form. This is how you can quickly switch to the form in order to
enter a new record. When data records are showing on the list, and you
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Entering Data

wish to access a particular data record from the form, simply click the
mouse on any part of the data as it appears on the list.

The Insertion Bar

On the form, look at the 1st data entry box that is labeled "Name". Notice
the light vertical line that appears to the right of the darker vertical line that
separates the prompt area from the data area.

Insertion Bar
|

Mame

A

This lighter vertical line is where the program will insert characters when
you press a key on the keyboard. Refer to this line as the "insertion bar".

In this lesson you will enter the following data into the "Tutorial"

Entering New Data

database.
Name Project
Bob Martin
Mary Martin
Carol Freeman
Bob Freeman
Mary Hadley
Carol Martin
Bob Freeman
Bob Martin
Mary Freeman
Carol Martin
Bob Freeman
Carol Martin

Date

1/4/87
1/4/87
1/4/87
1/5/87
1/5/87
1/5/87
1/6/87
1/6/87
1/6/87
1/6/87
1/6/87
1/6/87

Hours
3.5
4.8
6.0
52
4.7
7.3
4.6
3.2
6.5
4.6
3.5
4.6

Rate
55.00
50.00
55.00
55.00
50.00
55.00
55.00
55.00
50.00
50.00
50.00
50.00
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Entering Data

wish to access a particular data record from the form, simply click the
mouse on any part of the data as it appears on the list.

The Insertion Bar

On the form, look at the 1st data entry box that is labeled "Name". Notice
the light vertical line that appears to the right of the darker vertical line that
separates the prompt area from the data area.

Mame

This lighter vertical line is where the program will insert characters when
you press a key on the keyboard. Refer to this line as the "insertion bar".

In this lesson you will enter the following data into the "Tutorial"

Entering New Data

database.
Name Project
Bob Martin
Mary Martin
Carol Freeman
Bob Freeman
Mary Hadley
Carol Martin
Bob Freeman
Bob Martin
Mary Freeman
Carol Martin
Bob Freeman
Carol Martin

Date

1/4/87
1/4/87
1/4/87
1/5/87
1/5/87
1/5/87
1/6/87
1/6/87
1/6/87
1/6/87
1/6/87
1/6/87

Hours
3.5
4.8
6.0
52
4.7
73
4.6
32
6.5
4.6
3.5
4.6

Rate
55.00
50.00
55.00
55.00
50.00
55.00
55.00
55.00
50.00
50.00
50.00
50.00
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Looking at the form, notice that the insertion bar is in the data entry box
for "Name". Type in the name Bob and press the keyboard character
labeled TAB. The TAB key is used to advance from one data entry box to
the next. After TAB is pressed, the program moves the insertion bar into
the "Project” data entry box.

& File Column Select Sort Options Print Uiew

Tutorial

Next, enter Martin, press TAB, enter 1/4/87, press TAB, enter 3.5,

press TAB, enter 55,00 and press TAB. If you make a mistake and enter
an incorrect character, use the BACKSPACE key to remove the unwanted
character and retype it correctly. You should now have the complete first
record (line) of data entered and visible in your form. The next step is to
instruct the program to accept this data. Click the mouse in the button
labeled "Accept” that appears at the lower left corner of the form.

¢ File Column Select Sort Options Print View

Tutorial

Martin

1/4/87
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Entering Data

The program responds by accepting the form's information into the
database, clearing the form, and positioning the insertion bar at the first
data entry box on the form. The form is now ready for you to enter
another record.

Repeating Previous Data
To begin to enter the second line of data, enter Mary and press TAB.

You should now see the insertion bar in the "Project” data entry box. If
you refer back to the list of data to be entered, you will see that "Martin" is
used as the "Project” for both the first and second line of information.
Instead of entering "Martin" again, simply press the RETURN key. The
program responds by entering "Martin" for you. Whenever you press the
RETURN key in an empty data entry box, and you have previously
instructed the program to accept a record, SoftWoodGS File will duplicate
the data previously entered in that box into the current form. This feature
is referred to as "Repeat Data Entry”. It comes in handy when entering
records with similar data.

Now the insertion bar should be in the "The Date" data entry box. Since
the date to be entered is the same as the date you entered in the previous
record, simply press the RETURN key instead of entering the date.
Notice that the program enters and formats the date for you.

Next, enter the remaining data from the second row of the data, but stop
before you press TAB after the "Hours" data. Instead of pressing TAB
after hours, press the RETURN key. The program responds by accepting
the record. This is a shortcut way to accept data. You may use it instead
of clicking the mouse on the "Accept" button. When entering records, it is
faster to press the RETURN key to accept a record than to remove your
hand from the keyboard, grab the mouse, move the mouse pointer into the
"Accept" button, and click the mouse button. In order to accept a record
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with the RETURN key, however, the insertion bar must be in the last data
entry box on the form.

NOTE. Although "Bill" is the last box on the form, it is for a calculation
and not used for data entry. Therefore, "Rate" is the last data entry box.

Automatic Capitalization of First Character

Now, you can enter the third row of data from the list shown earlier.
Before you begin to enter the name Carol, enter a lower case "c" instead of
"C". Observe that the program automatically converts "¢" into "C". This
feature is for your convenience and may be disabled, if not wanted. The
feature is initially "ON" by default, and when on, SoftWood GS File will
optionally capitalize the first character of each word.

At this time, enter the remaining information in the third row and instruct
the program to accept the information.

Next, enter the remaining rows of information from the list shown earlier.

Quick Access of List

In a previous lesson you learned how to go from the form to the list by
choosing "List" from the "Options" menu. There is an alternate and more
convenient way to do this. Position the mouse pointer so that it is in the
vicinity of (not within) the buttons (Accept, Delete, etc.) at the bottom of
the form.
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Entering Data

Click the left mouse button. The program responds by displaying the
database in column format just as if you had selected "List" from the
"Options" menu. Next, click the left mouse button once in the up arrow
portion of the right scroll bar. Now you should see all of the data you
have entered as in the screen below.

& File Column Select Sort Options Print View

Tutorial

Project Date

Martin Jan 4 87
Martin Jan 4 87
Freeman Jan 4 87
Freemen Jan 5 87
Hadley Jan 5 87
Martin Jan 5 87
Freeman Jan 6 87
Martin Jan 6 87
Freeman Jan 6 87
Martin Jan 6 87
Freaman Jan 6 87
Martin Jan 6 87

ViBINIOIUN:DNIWIN]—

Modifying Existing Records

Up until now you have entered new information into your database. Often
you will want to modify information that you have already entered. Your
computer screen should now be displaying your database in the list
format. Lets say that the record in line #11 of the list is incorrect because
the name "Bob" should be "Mary". Position the mouse pointer over the
word "Bob" and click the left mouse button. The program responds by
displaying the form complete with the information from line 11. Notice
that the insertion bar is after "b" in "Bob". Use the BACKSPACE key to
remove the three characters "Bob". Next type in Mary.
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Also, lets say that the hours (3.50) should instead be 3.7. Since the
insertion bar is not at the hours data entry box, you must advance it so that
itis. Press the TAB key. The program advances the insertion bar to the
next box. Continue pressing TAB until the insertion bar is in the "Hours"
box. Use the BACKSPACE key to remove the 50 from 3.50 and enter a
7. The hours should now read 3.7.

In order to save the modified record, you must once again instruct the
program to accept the data. Do this by clicking the mouse in the "Accept"
button. The program responds by replacing the previous version of the
record with the new version. Now, return to the list format by clicking
the mouse in the vicinity of the buttons at the bottom of the form. The
program should respond by displaying the database in the list format.

Deleting Existing Records

Sometimes you will want to remove a record that you have already
entered. To learn how to do this, you will delete record # 12 from your
database. Position the mouse pointer so that it is over the number 12 and
click the left mouse button. The program responds by displaying the
database form along with the record at line 12. Click the mouse in the
button labeled "Delete”.

The program responds by deleting the record from the database. If you
would have clicked the mouse in the "Cancel" button, the record would
not have been deleted.
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Entering Data

Now save the changes that you made to your database by choosing "Save"
from the "File" menu. Also, instruct the program to return to the list
format as you have on other occasions.

Summary

Now you have a database that contains 11 records of information. You
know how to enter information into your database, modify existing
information, and delete existing information. In the next chapter you will
learn how to manipulate the data in the database by searching for specific
information and arranging it in desired orders. Since you saved the
database in the previous section titled "Deleting Existing Records", you
may quit the program and start the next lesson at a later time.
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Chapter 2.4

In this lesson, you will learn how to manipulate data in a SoftWood GS
File database by arranging your data in desired sequences and selecting
records that meet specific search criteria. At this time start the SoftWood
GS File program (if not already started), and open the "Tutorial" database
(if not already opened).

Sorting Columns

Records, or rows of a database may be arranged in a variety of sequences.
Select the "Name" column by moving the mouse pointer over the column
title "Name" and clicking the left mouse button.

& File Column Select Sort Options Print Diew
Tutorial |
Project Numek Date Hours Rate Bilt 1
. 1 Martin | Bob Jan 4 87 35 $55 $192
§ 2 |Martin  iMary Jan 4 87 4.8 $50 $240 |

High to Low

Project
1 Martin
2 Martin

singte Loluma Hours; Rate Bitt
Progressive 3.5 $55| $192
oy e 48] §50]  $240

—Ziml >

SoftWood GS File responds by sorting and then redisplaying all records
in your list. The records with names beginning with letters towards the
beginning of the alphabet will appear first.
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Sorting and Searching

Sometimes you may want to sort on more than one column. In the above
example, all names are sorted together. What may be more meaningful is
to separate names first by date. To do this, first click the mouse on the
"The Date" column title. Next, select "Low to High" from the "Sort"
menu. The program responds by sorting all records by date and
displaying them in that order. Next, select "Progressive" from the "Sort"
menu. This tells SoftWood GS File that it is to remember the last sort
when performing the next sort. Next, click the mouse on the "Name"
column title and choose "Low to High" from the "Sort" menu. When the
program redisplays the database this time, the records will be separated
and in order first by "The Date" and then "Name",

In the above example, you arranged information in what is referred to as
ascending order. In ascending order, data starting with numbers are
sorted first, followed by data starting with letters from "A" to "Z". The
reverse of this order is referred to as descending order. In descending
order, data starting with letters from "Z" to "A" appear first followed by
numbers that are arranged from largest to smallest value.

Your list is now sorted in a multi-column or progressive sort. Access the
"Sort" menu and observe the check mark that is beside the word
"Progressive”. Whenever the check mark is beside "Progressive”, a new
sort specification will always remember the previous sort(s). At this time,
choose "Single Column" from the "Sort" menu. Once again access the
"Sort" menu and observe that now the check mark is beside the words
"Single Column". When the check mark is next to "Single Column", you
are able to begin a new sort rather than build upon a previous one.

Save your database by choosing "Save" from the "File" menu. The next
time you open the database, it will still be sorted as it is now.
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Searching For Data

Now we will produce a list of all time reported for the Martin project. To
do this, first click the mouse on the "Project” column title.

& File Column Select Sort Options Print View

Tutorial

Project Date
Martin® Jan 4 87
Freeman Jan 4 87

By Enamp
By Range

Prd it ttems
Mal Selected {tems
Fregéman | LArov

SoftWood GS File will display a dialogue that asks for criteria to be used
in selecting records by their "Project” data. Eenter Martin (use either
upper or lower case) in the area provided for data entry.

Proiact |Name i patel Hours! Bate Bill
1 M4
Include r—ﬁ $192
2 1Fl O enclude o $330
3 mMg Information when data $240
4 Frll in column Project $286
® =
5  |Md Oo $401
6 He O( $235
7 |Fr] Q> $253
O A Q= $176
5 " rd 81 $230
10 _{Ertl [Martin] ‘ §325
11 Fr $185
New - - .
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Sorting and Searching

Click the mouse on the OK Button. The list that appears will be only time
reported for the Martin project.

Now click the mouse on the "Hours" column title. Next, select "By
Range" from the "Select" menu. The program then displays a dialogue
used to specify range selection criteria. Enter 4.0 in the data entry area
labeled "Is From". Next, enter 999999 in the area labeled "Through".
Click the mouse in the OK dialogue window's OK button. SoftWood GS
File now narrows the list of time reported on the Martin project to only
those entries with hours greater than or equal to 4.

Switching Between Selected and Full List

You may switch back and forth between a selected list of records and the
complete database by either choosing "Selected Items" or "All Items" from
the "Select”" menu. At this time access the "Select" menu and observe the
check mark next to "Selected Items". This check mark indicates that your
list is currently showing only a portion of your database. Now choose "
All Items" from the "Select" menu. The program responds by drawing the
full database. Once again, access the "Select”" menu and observe that now
the check mark is next to "All Items".

SoftWood GS File will retain the last selected list of information so that
you can switch back and forth from selected records to the full database as
desired. When a database is opened, however, any selected list that
existed prior to the database being saved must be reselected.

Summary

Now you know how to arrange and search through your database. In the
next chapter you will learn how to change the justification of columns,
print the list report, and print the label report.
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Chapter 2.5

In this lesson, you will learn how to set up columns for reports, print
reports, and print labels. At this time start the SoftWood GS File program
(if not already started), and open the "Tutorial" database (if not already
opened).

Justifying Columns

Data within columns may be shown as left, right, or center justified.
SoftWood GS File sets up the justification for columns by default
depending upon the type of column. For example, when amounts and
dates are defined they are set to be displayed right justified.

Name Name Name
Carolyn Carolyn Carolyn
Left Justified Center Justified Right Justified

Click the mouse on the "Rate" column title. Next select "Center" from the
"Column" menu. The program responds by displaying the column with
"Rate" data centered between its column boundaries.

In order for the "Rate" column to be centered the next time you open your
database, choose "Save" from the "File" menu. The program responds by
updating your database on disk.

Showing and Hiding Columns

At times you will not want information in one or more of your columns to
appear, This is usually when you are defining a report. It can also occur
when you are showing information to someone else and wish to hide
certain information. For example, a price listing shown to a customer
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Printing Reports

should not include your cost of the item. SoftWood GS File allows you
to determine which columns are to be shown via the "Show", "Hide",
"Show All", and "Hide All" commands in the "Column" menu.

& File Column Select Sort Options Print View

Tutorial
Project |Name Date| Hours| Rate Bl
| { Martin Bob Jan 4 87 35 $55'< $192
- 2 |FreemaniCarol Jan 4 87 6.0 $55 $330

Click the mouse on the "Rate" column title. Next choose "Hide" from the

"Column" menu. Notice how the program replaces the rates with a gray
color.

& File Column Select Sort Options Print Uiew

Tutorial

Projact Bate Hours § Rate i
Martin Jan 4 87
Freeman Jah 4 87
Martin Jan 4 87
Freaman Jan 5 87
Martin Jan 5 87

W

Hadley Jan 3 87
Freemoan Jan 6 87

Martin Jan 6 87
Martin Jan 6 87
Freeman Jan 6 87
Freeman Jan 6 87

O iU DIWIN —
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If you printed a report now, the "Rate" column would be excluded from
the report. On the list screen, however, the column is just "grayed" - this
allows you to continue to manipulate the column.
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Once again click the mouse on the "Rate" column title. Now choose
"Show" from the "Column" menu. The program responds by once again
displaying the rates.

Next, choose "Hide All" from the "Column" menu. Observe that all
columns now are shown in gray. Now click on the "Name" column title,
and choose "Show" from the "Column" menu. Notice that only the
"Name" column is shown with data. Now click on the "Rate" column
title, and choose "Show" from the "Column" menu. Notice that now both
the "Name" and "Rate" columns show data. If you printed a report at this
time, only these two columns would appear - all other columns would be
excluded completely.

Finally, choose "Show All" from the "Column" menu. The program
responds by displaying the date in all of the columns.

Reports

There are two types of reports available in SoftWood GS File: the
columnar or list report, and the label report. The list report is available
whenever the list screen and columns appear on the screen. The label
report is available whenever the form is displayed. The definition of each
report depends upon the definition of the list or form.

The List Report

Reports printed when the list is displayed show records in a similar
fashion to what is on the list screen, The main difference is that the
column boundary lines and other grid lines do not appear. SoftWood GS
File also displays a report heading at the top of each list report page. The
report heading consists of the title of the list, and a page number. If any
amount columns are in the list, they are automatically totaled at the bottom
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Printing Reports

of the report. The width, order, format, and justification of columns are
the same as seen on the list screen. Any columns hidden with the "Hide"
or "Hide All" feature are completely excluded from the printed report.

At this time, make sure your printer is online and ready for printing,
Choose "To Printer” from the "Print" menu. The program responds by
printing your database in the list format. It may take a few seconds for
printing to begin.

The Label Report

Reports printed when the form is displayed show records in a similar
fashion to what is on the form screen. The main difference is that only the
data is shown - not the complete data entry box. Also, fields on the same
line are compacted together separated only by a space. This allows you to
print labels neatly.

Choose "To Printer" from the "Print" menu. The program responds by
printing your database in the label format.

Summary

You now know how to justify columns, show and hide columns, and
print reports. In the next chapter you will learn about "Views", "Views"
allow you to save report definitions and much more.

If you exit SoftWood GS File now, the program will ask if you wish to
save changes made to the database. If this occurs, respond "No". The
reason "No" is appropriate is that the only changes you made to your
database were by using the show and hide commands. Since you did not
make any changes that should be saved, there is no reason to resave the
database.
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Chapter 2.6

In this lesson, you will learn how to define and access "Views". At this
time start the SoftWood GS File program (if not already started), and open
the "Tutorial" database (if not already opened).

Views

A SoftWood GS File "View" is a definition of a way to look at a database.
A "View" definition includes column order, column width, column
justification, report page definitions, form definitions, and sort sequences
for a SoftWood GS File database. A single SoftWood GS File database
may have many different "Views". No data is saved in a "View", only
display definitions.

The purpose of Views is to allow you to save and later recall different
display definitions of your database. For example, if you print more than
one type of report from your database, you could save each report
definition in a separate View. Then when you wanted to print a report,
you would access the View that contained that report's definition. This
frees you from redefining each report every time you want to print it.
Another use of a View is to save different sort sequences. If you normally
arrange your columns in different sort orders, you could create a View for
each order. Then instead of specifying the sort order, you would simply
access the View that contained the sort definition. There are many other
uses of Views that you will discover as you begin to use your data,

Creating Views

It is simple to create a View - all you do is save the current database
display definition. The thing to be aware of is whether you are currently
working within a View or not when you save the View.

~ Choose "New" from the "View" menu. This will ensure that you are
creating a new View. Although nothing seems to happen when you
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Using Views

choose "New", the program now knows that whenever you choose
"Save" from the "View" menu, you are creating a new View rather than
modifying an existing one that may currently be open.

To see some of the usefullness of the "View" feature you will now modify
your database definition and save this definition as a View. You will,
however, not save the database - only a view of the database.

Move the "Project” column so that it appears before the "Bill" column.
Next, sort the "Bill" column High to Low. Now hide the "Rate" column.
Finally, change the justification of the "Project" column so that its data is
right-justified. You have now modified the display definition of your
database from what it currently is saved as.

Choose "Save" from the "View" menu. The program responds by
displaying a dialogue window that allows you to give your View a name.
Enter MY VIEW as the name of your View. Now click the mouse on the
OK button. The program responds by saving the current display
definition to the disk.

Choose "Abandon" from the "File" menu. The program responds by
warning you that all changes are about to be lost. Since all you wanted to
do was to create a View and not modify the actual database definition,
click the mouse on the OK button. The program responds by clearing
your database from the screen.

Accessing a View

When you have Views defined, you can open a View instead of opening
your database. When you do this the program will automatically open the
database that the View is defined for. Choose "Open" from the "View"
menu. The program responds by displaying a file selector dialogue
window containing a list of all Views on your disk.
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The View you are interested in now is the one saved above titled
"My View".

Click the mouse on its name in the dialogue window's list. The program
responds by opening your database, sorting the records in descending
order by their "Bill" amount, and displaying the records on the screen.
Notice that the column definitions are just as they were when you saved
the View.

Modifying a View
At times you may wish to modify the definition of a View. Currently, you

are accessing the View titled "MyView". Let's say that you would rather
the sort sequence be by the "Name" column rather than by "Bill".

Sort the list by "Name" in "Low to High" order. Now choose "Save"
from the "View" menu. The program responds by asking if the existing
View definition is to be replaced. Click the mouse in the YES button.
The program will then replace the old View definition with the new one.
The next time you access this view, the database will be sorted by
"Name".

An important thing to keep in mind at this point is that if you opened your
database via the "File" menu, the sequence of records and display
definition would be different than what you see now.

Summary

This lesson is the end of the tutorial. You may quit the program now or
continue to experiment. You now know enough about SoftWood GS
File to manage your data. There are additional features in the program
than what was covered in the tutorial. To learn about these features, read
about them in the "Menu" section of the "Reference” section.
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Using Views

Notes...
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Chapter 3.1

The environment in which SoftWood GS File operates is shown in the
screen below. Not shown, but also part of the operating environment are
dialogue windows that prompt for and collect additional information when
necessary, and menu items that allow access to the program's functions.

The List

The area within the window drawn with vertical and horizontal lines is the
window's list area. The list area is comprised of rows and columns.
Each row contains information for a related set of items. Within a row,

each column contains a specific instance of data.

& File Column Select Sort Options Print Diew

Southwest Real Estate For Sale

Dwelling

Location

Beds

Baths

Garage

Price

House

San Francisco

[51]

E-N

4

$5,000,000 | }

House

San Clemente

$4,000,000

House

Malibu

$1,400,000

Penthouse

Century City

$1,250,000

Beach House

Malibu

$1,000,000

House

Tucson

$900,000

Beach House

Santa Barbara

$750,000

Wi WiNG —

Beach House

Santa Barbara

$600,000

House

Santa Barbere

$500,000

House

San Francisco

Wi WIN Wi N WIiDiU

MW WININ W WiW b

4
3
Y
2
2
N
2
3
\

$450,000

Duplex

Encino

N
~
N

$450,000

House

San Francisco

N

$400,000

Each instance of data (or cell) in the column titled "Location" in the above

screen tells where the dwelling described on that row is located.

54  Chapter 3.1 - Operating Environment




Operating Environment

Column Boundaries

The vertical lines dividing columns are referred to as column boundaries.
In addition to visually separating columns on the screen, column
boundaries are also used for changing column widths.

Column Selectors

The enclosed area above each column that contains the name of the column
is a Column Selector. When the left mouse button is pressed within a
column selector, that column is referred to as being "selected".

% File Column Select Sort Options Print Uiew

Tutorial

Project Date

tMartin Jan 4 87
Martin Jan 4 87

Scroll Bars

Along the right side of the window's list area is an area containing at its
top an arrow pointing upward; and at its bottom, an arrow pointing
downward. This entire area is a scroll bar. A scroll bar allows you to
access things not currently on the screen. Each scroll bar has its own
purpose. The scroll bar on the right side of the list area allows you to
access rows of database information that are off the screen. The scroll bar
on the bottom of the list area allows you to access columns of database
information that are off the screen. On the form screen, the left scroll bar
allows you to access form lines.

There are four areas of a scroll bar: up arrow, down arrow, thumb, and

shaft. Each area is activated by either clicking or pressing and holding the
mouse down in the area. The arrows scroll information a small increment

Chapter 3.1 - Operating Environment 55



at a time. For example, the right scroll bar arrows show one row at a
time. The shaft separates the two arrows. It allows you to scroll
information in large increments. The right scroll bar shows 12 lines at a
time. The thumb is the white box inside the shaft. By pressing the left
mouse button down in the thumb, and dragging the thumb to a different
area within the shaft, you are able to position the list as desired. For
example, if you drag the thumb to the bottom of the right arrow's shaft,
you will position the list to show the last row of database information.

Arrows
11
.%. 3
Thumb Shaft
The Form

The Form is used to enter new information into a database. It is also used
to modify existing information, and to delete existing information.

& File Column Select Sort Options Print Uiew

T T v e ey T

Tutarial

Acenp

56 Chapter 3.1 - Operating Environment



Operating Environment

The rectangular areas within a form are referred to as data entry boxes.
Data entry boxes may be moved and resized as needed. Up to eight boxes
may be placed on a single line. You may have as many as 32 lines on a
form.

The Menu Bar

At the top of the screen is a menu bar which allows access to many of
SoftWood GS File's features. To view the items within a menu title, press
the mouse button down on top of a menu's title. All of the items
belonging to that menu will then appear. You can choose a desired item
by dragging the mouse down and releasing its button when the item is
drawn as "By Example" is below.

& Fite Column LE[HAiSort Options Print lView Views

B Ena!nnle\:  wr o
By Range

it ttems

Setectod tems
gran | Larol

As a shortcut, some menu items may be selected by pressing the "Open
Apple" key and a letter key simultaneously. The letter seen to the right of
these menu items is the letter to be used. For example, Open Apple-E will
select the "By Example" function from the "Select" menu.

Dialogue Windows

Occasionally, you will need to supply the computer with more complex
information in order for it to initiate or complete a particular task. This
will be done from a SoftWood GS File dialogue window. Each dialogue
window requires some type of response from you before you can
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continue. For example, if you want to define a new column, a dialogue
window is used to allow you to specify the name of the new column and

its type.

& File Select Sort Options Print Diews

Untitled

Column Type @

Ves/No —
Phone
Date Alpha
Time A/N

When a dialogue window contains a button labeled "Cancel", you have the
ability to cancel any action that will occur as a result of using the dialogue
window. Dialogue windows that merely show information do not allow
you to cancel them.

Summary

This chapter described the components of the SoftWood GS File operating
environment. The next chapter discusses one of these components,
menus, in more detail by describing the purpose and use of each menu and
its items.
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Operating Environment

Notes...
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Chapter 3.2

Menu items provide access to most of SoftWood GS File's functions.
This chapter describes each menu item and the function it performs. The

menus are: Desk, File,

Column, Select, Sort, Options, Print, and Views,

System ( & File Column Select Sort Options Print liew

File / System
Status

Memory Usage

Default Numeric
Format

Default Date
Format

About SoftWood
GS File

60 Chapter3.2: Menus

provides information about an open database and
its memory and disk storage requirements.

provides information about the use of computer
memory. The RAM file space refers to the amount
of the computer's memory which is reserved for a
SoftWood GS File database.

allows you to specify the default display format of
"Amount" and "Calc" type columns. The default
definition is used by SoftWood GS File when you
define new columns.

allows you to specify the default display format of
"Date" type columns. The default definition is
used when you define new columns.

contains SoftWood GS File copyright and release
version information.



Menus

File [6 Filgﬁcmumn Select Sort Options Print View ,

Open allows access (i.e., reads and makes available) to
an existing database. It is available when no
changes have been made to a database since it was
last saved. When you select "Open" the system
displays a list of SoftWood GS File databases from
which you may choose from.

New makes a new untitled database available for use.
This menu item is available when no changes have
been made to a database since last saved or
initialized. The result of this action is the same as
when SoftWood GS File is first started.

Save writes to disk a database that is currently open.
Use this command when you have made changes to
the database since it was last saved or initialized.
During data entry it is important to save
periodically. Remember that changes to a database
are not permanent until saved to the disk.

When a new database is saved for the first time the
program will ask you to name the database. If the

name you enter is already in use, the program will

warn you and ask if you wish to replace it with the
one being saved.

When an existing database is saved, the program

will replace the version currently on disk with the
new version.
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Save As

Abandon

Open Ascii

Open AppleWorks
Def.

Open AppleWorks
Data

Save Mail / Merge

62

Chapter 3.2: Menus

writes to disk a duplicate copy of the database that
is currently open. Use this command when you
want to make a copy of your database. When you
select "Save As" the program ask you for a name it
can use when it saves the copy to disk. When it
asks for the name, the program provides a default
name. You should modify this name as desired. If
you want the database to show up on the "Open"
directory.

cancels all changes made to a database since it was
last saved or initialized (New). It also automatic-
ally closes an open database. This menu item is
available when changes have been made to a
database since it was last saved or initialized. Once
"Abandon" is performed, the system returns to the
same state as when it was first started.

converts an ascii disk file into a SoftWood GS File
database. In order for this item to be available, you
must have defined the columns that are to receive
the data. The columns must agree in number and
type to the data in the ascii file to be converted.

defines a SoftWood GS File database from an
Appleworks database (Step 1).

reads data from an Appleworks database into a
SoftWood GS File database (Step 2).

converts a SoftWood GS File database into an ascii
disk file. The format of the created file is that each
field of data is separated by a comma, data with
embedded commas enclosed by quotes, and



Rename

Delete

Title List

Quit

Column

Show

Hide

Show All

Hide All

Menus

each record is terminated by a linefeed (OAh) code.
This file may then be merged by a word processor
that accepts files of this type for mail/merging.

Renames an opened SoftWood GS File database to
a new name.

removes an opened SoftWood GS File database
from the disk.

is used to specify the title seen above the list and
form screens. This name is also used in the
heading of reports.

allows you to exit SoftWood GS File. If changes
have been made, you are asked if changes are to be
saved. If yourespond "Yes", and the database has
not been saved, the program will ask for a name.

L'i File Eolunln Select Sort Options Print View ]

displays data in a column that has been hidden with
the "Hide" or "Hide All" feature (explained below).
It is available whenever a "hidden" column is
selected.

conceals data in a column. It is available whenever
a column that is not already "hidden" is selected.

displays the data in all columns on the list.

conceals the data in all columns on the list.
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Left

Center

Right

Display Format

Define Data

Define Calc

Delete

64 Chapter3.2: Menus

aligns data in a column so that the first character of
data will be next to the left column boundary. This
item is available whenever a column is selected. If
the column is already left justified, a check mark
will appear beside the menu item.

aligns data in a column so that the characters are
centered between the left and right boundaries of
the column.

aligns data in a column so that the last character of
data will be next to the right column boundary.

allows you to change the way an "Amount",
"Calc", or "Date" type column is displayed on the
list and printed reports. The menu item is enabled
whenever a column of one of the above three types
is selected. Use this feature if you wish to override
the default display format used when a column is
defined for the first time.

allows you to insert a new data entry field into your
database. When you define a field, the program
adds a new column to your list and a new data
entry box to your form,

allows you to insert a new calculation field into
your database. When you define a calculation, the
program asks for a formula.

is used to permanently remove a field (Data or
Calc) from your database. When a field is deleted,
its column is removed from the list and its data



Menus

entry box is removed from the form. When field is
deleted, all data entered into the field is also
deleted.

Select [.t File Column Select Sort Oplions Print Uiew —l

By Example

By Range

All Items

Selected Items

displays a dialogue window that allows you to
specify example search criteria. From this criteria
the program creates a selected list of records (rows)
and displays them on the list.

displays a dialogue window that allows you to
specify range search criteria. From this criteria the
program creates a selected list of records and
displays them on the list.

instructs the system to include all database records
in the list.

instructs the system to include only database
records contained in the previous search created by
example or range.

Sort lo’t File Column Select Sort Options Print iew 1

Low to High

High to Low

R

arranges in ascending sequence (A comes before B)
information in a list. The arrangement is based
upon data in either a single column or multiple
columns depending upon the sort mode (Single or
Progressive).

arranges in descending sequence (B comes before
A) information in a list. The arrangement is based
upon data in either a single column or multiple
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Single Column

Progressive

columns depending upon the sort mode (Single or
Progressive).

indicates that a sort is to be performed on a single
column only.

indicates that the program is to perform sorts that
remember previous (sorts). All progressive sorts
should begin with a "single column" sort.

Options F& File Column Select Sort Options Print View

Form

List

Auto Capitalize

Grid On/Off
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accesses a database's form when at the list. At
least one data column must be defined before the
form may be accessed.

accesses a database's list when at the form.

automatically converts a lower case letter entered as
the first letter in a word to upper case. For
example, "charles" typed from the keyboard would
result in "Charles". This feature is optional and
may be disabled. A check mark next to the "Auto-
Capitalize" menu item indicates the feature is on.
Disable it by selecting it when it is checked.

controls whether or not the lines separating rows
and columns on the list are to be drawn on the
screen. This does not affect printed reports. A
check mark next to "Grid On/Off" indicates the grid
is on. Disable it by selecting it when it is checked.



Menus

Repeat Data Entry allows you to conveniently repeat data entered in a

previous record while doing data entry. This
feature is optional and may be disabled. A check
mark next to the "Repeat Data Entry" indicates the
feature is on. Disable it by selecting it when it is
checked.

Field Info gives information about a field being entered. This
feature is only available during data entry while the
form screen is on display.

Print [6 Fite Column Select Sort Options Prirgt Uiew I

%
To Printer prints a list or label report to the printer. Labels get

To Ascii File

Page Setup

printed when this item is chosen when the form is
in view.

creates a list or label report and saves it in a disk
file. You will be asked to provide a name for the
disk file when you select this feature. An Ascii
print file is a formatted report that may be printed
later or read into a word processor. Be careful not
to print large database reports to disk when your
disk may not have enough free space for the disk
file. This feature is mostly intended to transfer a
very small list or group of labels into a word
processing document.

allows you to specify print environment options.
The options that may be specified depend whether
or not this menu item is chosen when at the list or
at the form.
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VieWS |é File Column Select Sort Options Print Biew

Open

New

Save

Save As

Rename

Delete
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allows you to access a saved View. When this item
is selected the program displays a directory of
Views on the disk. When a View is "Opened" the
program automatically "Opens" the database for
which the View was defined.

allows you to indicate that a new View definition is
to occur. When this item is selected, although
nothing seems to happen on the screen, the
program sets certain internal conditions. The
purpose of this command is to allow you to define
anew View without affecting another that may be
currently open.

writes to disk a View definition. If the View is
new, the program asks you for a name. If the
View already exists, the program asks you if you
wish to replace the existing View with the current
definition.

makes a duplicate copy of a View definition.

allows you to change the name of the view as seen
in the View Open directory.

permanently removes a View definition from the
disk. When this item is selected, the program asks
you if you are sure you want to delete the View.



Menus

Notes...
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Appendix A

Access Form

A fast way to get to the form from the list is to position the mouse pointer
on a row in the list and pressing the left mouse button. If the row
contained data, that data will appear in the form when it is displayed.

& File Column Select Sort Options Print Uiew

Tutorial

Project {Name The Date] Hours Rate Bill

Access List

A fast way to get to the list from the form is to position the mouse pointer
in the vicinity (not inside) of the buttons at the bottom of the form and
clicking the left mouse button. If the form contains data when the mouse
is clicked, the list will begin with the row that contains that data.

] veinte

Menu Keyboard Keys

A fast way to choose some menu items is to press the combination of the
"Open Apple" key (left side of space bar) and a letter. The following
available menu keyboard keys:
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File Menu
Open Apple O
Open Apple S

Open Apple Q

Column Menu
Open Apple D
Open Apple C

Select Menu
Open Apple E
Open Apple R

Options Menu
Open Apple F
Open Apple L
Open Apple U
Open Apple G
Open Apple H

Print Menu
Open Apple P

Views Menu
Open Apple V

Short Cuts

Open
Save

Quit

Define Data
Define Calc

By Example
By Range

Form

List

Auto-Capitalize (On/Off)
Grid On/Off

Field Info

To Printer

Open
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The professional-quality, full-featured database management

8 Calculations...

@ Saved Report Formats...

B mmport & Convert
AppleWorks Databases...

system for the Apple IIGS

B Pull-Down Menus...

8 Written in “C”...

B Multi-field, Ascending
& Descending Sorting...

@ Vert/Horiz Scrolling...

B Eight (8) Field Types...

8 Selection by Example
& Range!

Spreadsheet Format provides

Column Select Sort Options Print Uiew

outhwest Real Estate For Sale

Dwelling Location Beds: Baths | Garage; Pool Price
1 |House Saen Francisco 5 4 4 Yes | $5,000,000
2 [House San Clemente | 5 | 4 4 iyes |$4,000,000
3 |House Malibu 4 3 3 Yes : $1,400,000
4 |Penthouse iCentury City 3 3 Y Yes | $1,250,000
S |Beach House iMalibu 3 3 2 No i$1,000,000
6 |[House Tucson 3 2 2 No $900,000
7 |Beach House { Santa Barbera ; 2 2 N No $750,000
8 |Beach House i Santa Barbare | 3 3 2 No $600,000 ||
9 |House Santa Barbara{ 5 3 3 Yes $500,000
0 |House San Francisco 3 2 Y No $450,000
1 |House Encino 4/4 3/3 2/2  iYes $450,000
2 |House Santa Monica 2 2 N $300,000 |

e

overview of the database.

Easily define column widths,

placement, and justification...

Format numeric fields with commas
dollar signs, and/or decimals...
Transfer quickly between full
database and selected record
Print columnar reports fr
list including automatic
headings and cumulatj
Transfer convenientls
selected record to

elect Sort Options Print Uiew

illustrations are representations of actual screens

Southwest Real Estate For Sale

[ bweliing

|House

Format mailing labels by

[ Location

|Sanla Barbeara I

positioning fields on form...

[ Beds

|3 | |Bﬁths |2 —| IEarage Yes

Automatic scrolling of data
within a field during data entry...

Optionally capitalize the first

| Price

[300000.00 ]

letter of each word automatically...
Modify form as needed for
convenient placement of data...
Data entry form automatically
created by system during

database definition!

Additional Features of the NEW SoftWood GS File

Save As...

Save label and report
formats via Views...

used to open databases...
International date formats...

SoftWood Company

Optional repeat data entry...
Scrollable database directory

P.O. Box 2280, Santa Barbara, CA 93120 |

Accept Delete New Undo
e

erge list creation and save...
ntal overflow on List reports...
t & convert foreign ASCII files...
national numeric formats...

port ASCII databases!

Apple, AppleWorks and Apple 11GS
' are trademarks of Apple Computer, Inc.

@ Copyright SoftWood Company, 1986, 87.




